Introduction

Wheeling Systems Checker is a Windows desktop program you can use if you want to check/analyze/improve your
coverings.

Starting from version 4.0.0 you need an active Internet connection and a valid subscription to the Covering Repository
website to use the program.

Please visit http://www.coveringrepository.com for more information.

System requirements

Operating system: Windows Vista SP2, Windows 7 SP1, Windows 8, Windows 8.1, Windows 10.
Architecture: 32 or 64 bits
RAM: 2GB minimum, 4GB+ recommended

NOT WORKING on Windows XP


http://www.coveringrepository.com/
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Launching the program

Once the program is installed you can launch it by clicking on the orange gear icon you should find on your desktop.

Uitlicallings)
4

The first time you run the program (starting from version 4.0.0) a form appears asking you to insert your account
information.
Please visit http://www.coveringrepository.com if you don’t own a subscription yet.

Account Info n

Account Info

Username |

Password

Proxy (required if you are behind a proxy)
Address

eq. hittpeymy.proxy.serven:80/F

|. Test parameters H Ok \

—_——

Insert your data and click the Test parameters button. If everything works as expected, a message stating parameters
are ok will appear in the status bar. Click the Ok button to close the form.

Account Info n

Account Info
Username useri@mail.com
Passwaord I IIL

Proxy (required if you are behind a proxy)
Address

eq. httpfmy.proxyserven:807

|. Test parameters H Ok \

| Prameiers Ok, comnection esatlistes. |



http://www.coveringrepository.com/

Preferences 1

Preferences are the first thing you should check and modify as per your liking.

Preferences n

File

Zero prefix numbers
Check inconsistent blacks
[] Use all the cores of the CPU to wark faster
Applies to
. Check system

. Coverage analysis
. Tools -> Search best covering blocks

Max uncovered blocks to see (max 5.000) 100

Theme |Silver -

| ok || appy |

Zero prefix numbers: if checked, all the grids and the reports will add a leading 0 (zero) to numbers less than 10. The
suggestion is to keep this option checked to avoid strange behaviors when blocks are sorted alphabetically.

Check inconsistent blocks: if checked, the program will raise an error if a manually inserted block is wrong (block
inconsistent with v and/or k parameters). Keep this checked to avoid strange behaviors.

Use all the cores of the CPU to work faster: some features of the program can take full advantage of the power of your
CPU. Select this option to check systems faster, for example.

Max uncovered blocks to see (max 5.000): limits the number of uncovered blocks, if any, that you want to see in the
relative grid.

Theme: the layout theme. Black, Light blue, Silver options are available. Choose one and click the Apply button to see
how the interface colors change.



Loading a system 1

To load a system, simply click on File -> Open system, or use the Ctrl + O keyboard shortcut, then browse to the folder
containing your file.

® Wheeling Systems Checker 4

System 7

Mew system Cirl+N
— OS] m[am | Crexestem |
‘E‘ Sawve syster Cirl+5 | Stop || ¥ ||LC|l:lpDﬁ:|
Save system as Cirl+ Alt+5
Save inverse £ma
Preferences
Account Info |
|| 123 || 321 |
Exit i ——
System blocks [1 {(Un)lock
3 [ {Unilock

The file should be a normal text file with one block in each line. Numbers can be separated by one or more blank spaces
(or tabs). Numbers can also be written with a zero prefix.

Example 1

010205 07
01030508
01050607
0203 04 06
02 04 06 08
0304 07 08

Example 2

1257
1358
1567
2346
2468
3478

It is not necessary to write numbers in increasing order. The following blocks are also recognized:

1752
8351
5176
4326
6842
4837

As an alternative, you can copy blocks from your text file (Ctrl + C) and paste them into the program (Ctrl + V).



When the system is loaded, the blocks are visible in the left grid.

—| v, k, t, m settings
Check system
vi sl k[ 4F t[3E m|aE] [ i ]
k combinations: 70 | stop || I |[Loop0ﬁ]
m combinations: 70
covered by 1 block: 17
inmemaory. 70
inverse: 08, 04, 03, 04
| abe || zpe || 123 || 321 |
System blocks [1 (Un)lock
* Click here to add a new row
3 01 02 05 07 | [ | {Unjlock
0103 05 08 O [ ok
01 05 06 07 | ' {Unjlock
02 03 04 06 O | wnilock
02 04 06 08 O [ ok
03 04 07 03 O [ ok

You can manually insert/edit/delete rows. You can also lock/unlock them (more about this later).

To edit a block, double click on it, modify it and then click Enter to confirm. To exit the edit mode without modifying,
press Esc on the keyboard.

More options are available in the System menu (image below).

File | System | 7

_E Check System Ctrl+F5
| & |cut Ctrl+X EI |
53 |copy Ctrl=C
|3, |Paste Ctrl+V
[as] 'X Delete
Select all
L Deselect all
Lock all 123
Unlock all blocks
# Lock selected here to ai
Unlock selected 05 07
M 030508
01 05 06 07
M N3 n0d Ne




Checking a system L]

When the system is loaded, you have to manually adjust the v, k, t and m parameters, if needed.
In the v, k, t, m settings panel you can see some information describing the current system.

k combinations: the number of combinations of v numbers taken k at a time.

m combinations: the number of combinations of v number taken m at a time.

covered by 1 block: how many m-blocks are covered by a single k-block (depends on t).

8 Whesling Systems Checker 4
File  System 7

v, k, t, m settings Progress report

Check system
t| 3 m| 4 & ! |

Sto [ Left to check: 0O
k combinations: 462 -top et |

m combinations: 330 Uncovered: 0
covered by 1 block: 65 AT SR 100,000000000000000%:
inmemary: 330
inverse: 11, 06, 05, 07

System blocks: 9

v 1B k| 5

Ak

Uncovered blocks | Coverage analysis  Too

| — || e || - || . | Uncovered blocks

System blocks [1 {(Un)lock

* Click here to add a new row

3 07 02 04 03 10 ‘ ] ‘l' Unilock ]|
01 03 06 07 09 O [ unilock |
0103 07 08 11 O | unilock |
010405101 O [ unilock |
02 03 05 07 09 O | wunilock |
020409 10 11 O [ wnleck |
02 05 06 07 11 O [ wnock |
03 04 06 03 10 O [ (unilock |
05 06 0T 08 09 O | unilock |

in memory: m-blocks saved in memory to speed up the check task.

inverse: the corresponding inverse parameters. Black numbers mean you can save the current system as inverse (File ->
Save inverse system as...). Grey numbers mean the inverse parameters are equal to the selected v, k, t, m parameters.
Red numbers mean the selected parameters do not have a corresponding inverse set of parameters.

Finally, when you press the Check system button, the program starts.
— A green progress bar appears informing you the program is checking the system.

|' Stap | |T| | Loop Off | Press the Stop button to terminate, press the Pause button || to suspend.

-ng system.. |




When the task is finished, in the Progress report panel you can see the result.

100% covered

Progress report
System blocks: 9
Left to check: O Iy
Uncovered: 0O

LS ET R 100, 000000000000000%

95,75% covered

Progress report
System blocks: &
Left to check: O Iy

Uncovered:

Coverage % EENETETETETETE L

In the second case 14 blocks are not covered.



Uncovered blocks 1

When a system is not 100% covered, you can see which m-blocks are not covered by inspecting the Uncovered blocks
grid.

Progress report

tystem blocks: 8 Blocks to amalyze:  --
lefttocheck: O Improvements found: -
Uncovered: 14 Best uncovering: -

Coverage %  EENETETETETETE LI Elapsed time:  --

Uncovered blocks | Coverage analysis  Tools  Additional tools ~ Cowvering tools

Uncovered blocks
01 02 03 05 Add block
01 02 05 09 Add block
02 03 04 05 Add block
02 03 04 07 Add block
02 03 0508 Add block
02 03 05 09 Add block
02030510 Add block
02 03 07 10 Add block
02 03 08 09 Add block
03 04 05 07 Add block
03 04 05 09 Add block
030507 10 Add block
03050910 Add block
030509 1 Add block

If k-blocks are of the same length of m-blocks, the Add block buttons are enabled and you can add one or more of the
uncovered blocks to the system blocks. In this case they are disabled because the current system parameters are
11, 05, 03, 04 and k (5) is not equal to m (4).



Coverage analysis

Coverage analysis tells you how many blocks are exclusively covered by each system block. From here you can delete

one or more blocks. You can also lock blocks (more about this later).

Uncovered blocks = Coverage analysis

Coverage analysis

Tools

Additional tools

| |:| Open coverage analysis in notepad

Covering tools

Shrinking tools

When you delete a block, the whole situation changes so you should perform a new coverage analysis whenever you

System blocks Blocks covered

0103 06 07 09 14 Delete Lock
0103 07 08 11 14 | Delete || Lok |
02 03 05 07 09 14 | Delete || Lok |
02 05 06 07 11 14 | Delete || Lok |
05 06 07 08 09 14 [ Detete || Lok |
0102 04 08 10 17 | Delete || Lok |
0204 09 10 11 17 | Delete || Lok |
03 04 06 08 10 18 | Delete || Lok |
010405 10 11 18 | Delete || Lok |

LI

delete a block. In the sample above, if you delete the first two blocks at the same time, the final uncovered blocks will
not be 28 but 37. In fact, if you delete the first one (01 03 06 07 09) and do a new coverage analysis, the second one (01
03 07 08 11) will exclusively cover 23 blocks instead of 14.

You can open the report in notepad by selecting the checkbox next to the Coverage analysis button.



Tools 1

Search coverage improvements

This function can help you reduce the number of uncovered blocks. Eventually locked blocks are not taken in
consideration and will not change throughout the process.

Uncovered blocks  Coverage analysis | Tools | Addiional tools  Coveningtools  Shrinking

Search coverage improvements

| Improve coverage 0 2| Max number of coverage improvements

|:| Open coverage improvements report in notepad |:|Autnmatic best block replacement
|:| Sort system blocks after bestblock replacement | abc -

Mumbers shared with each analyzed block
3 4

1] 1 2
OO
Max number of coverage improvements: to speed up the reduction process you can set a limit of improvements to find

after which the procedure starts again. To use in conjunction with Automatic best block replacement and Loop On.

Open coverage improvements report in notepad: a text file reporting all the possible improvements opens. Activating
this option automatically sets Loop Off.

Automatic best block replacement: if you select this option, the best block found replaces a block in the system blocks
grid.

Sort system block after best block replacement: you can sort system blocks in 4 ways after each replacement —
alphabetical, reverse alphabetical, numerical, reverse numerical.

Numbers shared with each analyzed block: if k = 5 and 4 is selected, the program will search for improvements between
the blocks which have 4 numbers in common with the current analyzed block.

Search best covering blocks

Search best covering blocks

| Search blocks | (®) Within all k combinations Within uncovered blocks

Mumbers shared with each system block
4] 1 3 4

2

Best blocks Covered blocks
0103 06 07 09 14 | Add block |
0103 04 06 09 12 | Add block |
0102 06 07 089 10 [ addblock |
0102 03 06 09 10 [ Add block |
0102 03 04 09 7 [ Addblock |
0102 03 04 06 7 [ addblock |
0102 03 04 05 2 [ Add block |




With this function you can search for the best covering blocks. If k = m you can limit the search to the uncovered blocks,
otherwise you will be able to search only within all k combinations. To add a block to the system blocks simply click the
Add block button.



Additional tools

Weights analysis

01030703 11

451203904380 [ Delete

03 04 06 03 10 [ Delete

Block Weight
05 06 07 08 09 841957031465 Delete
02 03 05 07 09 841957031465 [ Delete |
0103 06 07 09 841957031465 |  Delete
010204 08 10 808761799168 |  Delete
02 05 06 07 11 666580467922 |  Delete
02040910 11 633385235625 | Delete
010405 10 11 633385235625 |  Delete

| Delete |

| Delete |

458,008672082

The weight of a block is a value which depends on how many numbers a block has in common with all the other system
blocks. Higher the weight is, higher it is possible the block is a good candidate to delete. Usually the heaviest blocks are
the ones which exclusively cover the lowest number of blocks but sometimes they are not.

To delete one or more blocks, click on the corresponding Delete button.

Multi-covered blocks

Block Times COVEr...
03070309 4 [M@wMMM”Hmemmmﬂ
02 06 07 09 4 | Del. covering blacks || View covering blocks |
05 06 07 09 4 [ Del. covering blocks || View covering blocks |
03 06 07 08 4 | Del. covering blocks || View covering blocks |
03 05 06 07 4 | Del. covering blocks || View covering blocks |
0408 10 11 4 | Del. covering blacks || View covering blocks |
0102 03 07 3 [ Del. covering blocks || View covering blocks |
01 04 03 10 3 | Del. covering blocks || View covering blocks |
02 07 09 11 3 | Del. covering blocks || View covering blocks |
i NG NE KT 2 [ Pialrmunrine i) [ ikt

This report tells you which are the system blocks that are covered multiple times and which are the covering blocks.
Click Del. Covering blocks button to delete all the covering blocks. Click on View covering blocks button to open a report
in notepad. The number next to the covering blocks indicates how many numbers they have in common with the
covered block.

E tmp11EDtmp - Notepad

Eile Edit Format View Help
tovered block
B3 @7 88 @9

Covering blocks
81 83 ©6 ©7 B89 -
8l 83 97 88 11
82 83 @5 87 89
B85 86 ©7 88 B89

LI
LN [ W Wy N




System analysis

Mj tmpCE28.tmp - Notepad
File Edit Format Wiew Help

| 0 1 2 3 4

@1 82 94 08 10 4 1 3 - 808,761799168
@1 83 86 07 09 3 2 3 - 841,957031465
@1 83 87 08 11 1 6 1 - 491,203904380
@1 @4 @5 10 11 3 3 2 - 633,385235625
82 83 85 07 09 3 2 3 - 841,957031465
82 84 89 10 11 3 3 2 - 633,385235625
82 85 86 07 11 2 4 2 - 666,580467922
@3 @4 06 08 10 2 5 1 - 458,088672082
@5 86 87 08 09 3 2 3 - 841,957031465

Numerical distribution
g1 - 4

B2 -
B3 -
B4 -
B85 -
B6 -
87 -
B8 -
B9 -
18 -
11 -

F T I S

Normalized system blocks
681 82 83 84 as
61 83 84 838 11
81 85 87 18 11
81 86 87 89 16
62 83 84 89 11
62 86 B7 88 11
62 87 88 89 160
63 84 B85 86 16
65 86 B7 B8 @9

The first section of the report tells you how many numbers each block has in common with the other blocks and its
weight. In the example above, the block 01 02 04 08 10 has 1 number in common with 4 blocks, 2 numbers in common
with 1 block and 3 numbers in common with 3 blocks. Its weight is 808,761799168.

The second section tells you how many times a number is present within the system blocks.

The third section shows a normalized version of the original system.
The first block is changed to be in the form 01 02 03 04 05 and all the others are changed accordingly.



Covering tools 1

The covering tools can be used to try to improve the partial coverage of a not yet complete system, to complete a
system, or to generate one from scratch. In some cases, the program can generate systems from scratch that are
remarkably close to existing records, but this is not always the case, it depends on the values of k, t and m parameters.
Also, it is not recommended to use them for systems with hundreds or thousands of blocks or for systems that generate
millions of k and/or m combinations; in these cases, processing times are unfortunately still unacceptable.

Uncovered blocks  Coverage analysis  Tools  Additional tools | Covering tocls | Shrinking tools

[C] Tryto improve coverage first
0,00 = Coverage % to reach before deep search
1 F&{ Searchdepth
Limit deep search to the first ] 2| blocks [0 = no limit)
] = Max nr. of system blocks to reach (0 = no limit)

When finished (@) View blocks in notepad (_) Replace system blocks

Please note: if operation is cancelled by user, blocks will always open in notepad

Start Blocks found: -
Uncovered: -

Coverage % --

Steps: -

To analyze this step: -

Best this step: -

Try to improve coverage first: with the checkbox selected, the program will try to improve the existing coverage by
working on the current system blocks before starting the cycle in which it will try to improve it by making blocks
replacements.

Coverage % to reach before deep search: in this field you can set a coverage percentage (from 0 to 100) that you want
to reach before the program starts the cycle searching for improvements. In practice, blocks are added to the system
until the indicated coverage percentage is reached, after which the search begins. By setting the value to 100, the
program will not do anything once this percentage is reached; the value 100 can still have its use, as we will see later.

Search depth: the search depth is nothing more than the number of blocks the program will try to replace
simultaneously. 1 means that it will try to remove one block at a time and replace it with a better one. The higher the
value, the longer the program will take to complete the search. The existing blocks are first reordered by "weight" (not
by coverage) then the program tries to replace the heavier ones first. The number of steps needed to complete the cycle
is indicated next to the Steps label.

Limit deep search to the first “n” blocks (0 = no limit): if the system is composed of many blocks, this parameter can be
useful. It allows you to limit the number of blocks on which to attempt a replacement (if zero, it will not be taken into
consideration). In a 100 blocks system for example, with Search depth = 3 and a limit of 10, the program will try to
replace 3 blocks at a time by examining only the 10 heaviest blocks in the system.

Max nr. Of system blocks to reach (0 = no limit): this field allows you to limit the maximum number of blocks you want
the program to reach. If left at zero it will not be considered and blocks will be added until full coverage is achieved. For
example, if you have a 10 blocks system and set this parameter to 20, the program will add 10 blocks. If you want to



reach a certain number of blocks, instead of a percentage, before the program starts to cycle, you can set this parameter
and set the value Coverage % to reach before deep search to 100. Once the desired number of blocks is reached, the
program will stop by opening a text file with the required blocks that you can copy and paste as system blocks and, after
having reset the aforementioned percentage to zero, start to search for improvements. You can select the Replace
system blocks option to automatically replace the system blocks with the new blocks. If you manually stop processing,
new blocks always open in notepad.



Shrinking tools

L

Shrinking tools are a new feature introduced in version 4.0.0 to help you reduce the numbers of rows of your systems.
Speed and result depend on the v, k, t, m parameters and the number of blocks composing the system. As a rule, higher

the number of blocks covered by a single block is, slower the program will be able to find a way, if any, to shrink.

Please note: the program will not check if your system is 100% covered when you press the Shrink button. This means it

will probably stop at the end of the initialization task if you try to shrink an incomplete system.

The following image shows the Shrinking tools interface.

Progress report
System blocks: 19953
Left to check: -
Uncovered: -

Coverage % --

Uncovered blocks  Coverage analysis

Progress panel
Blocks: 19.782
Changed: 29
Attempts: 1
Steps: 2644

Task: cancelled..

Seed
() Default seed
(@) Random seed -1.921.300.839

() User seed ] =

Initial sort of system blocks
(_JMosort () Alphabetical (# Mum

Additional options
Play sound on improvement

[#] Use parallel to initialize

| Shrink

Progress panel

Blocks: the current number of blocks. When you start shrinking it is equal to the original system blocks.
Changed: number of changed blocks compared to the original system blocks, reset after each improvement.

Attempts: number of performed attempts (substitutions), reset after a new block is changed.

Elocks to analyze:
Improvements found:
Best uncovering:

Elapsed time:

Tools  Additional tools

erical (_) Shuffle

00:00:10

Coverning tools

Shrinking tools

mj tmp34EStmp - Motepad

File

p2
81
82
04
01
82
81
81
82
81
82
02
83
81
81
82
86
84
81
81
01
81

A

Edit

83
83
a3
a5
g4
a3
83
g2
84
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a3
a5
g2
83
a3
g7
a5
a3
a2
83
a3

(2%

a4
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B4
86
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Steps: in the initialization phase it corresponds to the number of analyzed original system blocks; in the shrinking phase
it indicates the number of steps taken within the system blocks while searching for a new attempt. Reset after each
improvement.

Seed

As many other programs do, the attempts made while searching for an improvement are based on casualty, so an initial
seed is set to try to vary the result. If the initial system is the same, as well as the initial sort (more about this later),
using the same seed will lead you to the same result.

Default seed: a fixed internal seed different from zero.
Random seed: a random seed changing every time you click the Shrink button.
User seed: you can use this seed to replicate a previous result or to finally take advantage of your lucky numbers!

Initial sort of system blocks
Here you can decide how to initially sort the system blocks. Whatever type of sort you choose, the program will always
remove duplicates first.

No sort: the blocks remain untouched.
Alphabetical: the blocks are sorted as they were strings, which means these 6 blocks

03040708
010506 07
0203 04 06
01020507
01030508
02 04 06 08

would be sorted this way

01020507
01030508
010506 07
0203 04 06
02 04 06 08
03040708

Numerical: when you load a system, all the blocks are translated to their correspondent binary representation.

Block 1 2 3 4 corresponds to the 8-bits representation 00001111 which, in turn, is decimal number 15.
20+ 27 + 272 + 2703 = 1+2+4+8 =15

so the previous 6 blocks would be sorted like this

02 03 04 06 => 46
01020507 =>83
01050607 =>113
01030508 =>149
0204 06 08 =>170
03 04 07 08 => 204

Shuffle: the blocks are randomly shuffled.

Additional options
Play sound on improvement: select to hear an annoying sound whenever an improvement is found (but very satisfying
sometimes).



Use parallel to initialize: the initialization phase can be speeded up by selecting this option which will use all the cores of
your CPU (overrides the global settings you find in preferences).

Very often the results tend to converge, regardless of the selected parameters, so the suggestion is to run more than
one session of the program each with a unique set of parameters.

The number of sessions that make sense to launch depends on the number of CPU cores available.

If a session works much better than the other ones, stop all the sessions, copy the blocks from the best session to each
session and restart without touching the parameters.

The best blocks open in a temporary .txt file when you click the Stop button. The program stops by itself only if no more
attempts are found.

If no attempts are found during the initialization, the program stops immediately and the shrinking phase does not even
begins.



